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Квантификация перестроек фибриллярного актина с использованием микрофотографий возможна не
только с помощью стандартного измерения относительной интенсивности флуоресценции, но и с помо-
щью разработанного нами нового подхода на базе расчета фрактальной размерности Минковского. Для
вычисления фрактальной размерности использовали плагин FracLac для ImageJ. Перестройки фибрил-
лярного актина выявляли в мезенхимных стволовых клетках человека линии FetMSC после воздействия
ингибитора полимеризации актина латрункулина Б или предсердного натрийуретического пептида, вли-
яние которого на актиновый цитоскелет мезенхимных стволовых клеток было обнаружено нами ранее.
Проведенный в данной работе анализ изображений выявил изменения параметра фрактальной размерно-
сти, отражающие реорганизацию микрофиламентов в нативных клетках. Полученные результаты демон-
стрируют, что фрактальная размерность Минковского является удобным инструментом для оценки пере-
строек фибриллярного актина и может использоваться, дополняя или заменяя результаты измерения от-
носительной интенсивности флуоресценции.
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Многие биологические структуры и клеточные
органеллы, такие как цитоскелет, комплекс Гольд-
жи, дендриты нейронов, внутренние мембраны ми-
тохондрий (кристы) обладают сложной геометриче-
ской формой. В ряде случаев количественная мор-
фометрическая оценка таких объектов практически
невозможна, что накладывает ограничения на при-
менение сравнительного анализа состояния данных
структур, например, при оценке действия различ-
ных биологически активных соединений. Одним из
решений может быть использование фрактальной
геометрии, в рамках которой изображения таких
структур рассматриваются как геометрические фи-
гуры, и далее проводится их количественная оценка
с применением фрактальной размерности Минков-
ского (ФРМ, или box-counting алгоритм; Karperien,
2004). Понятие “фрактал” впервые ввел Бенуа Ман-
дельброт (Mandelbrot, 1983), и по его определению
фрактал – это самоподобная структура, а фракталь-
ная размерность – это мера ее геометрической слож-

ности. Для проведения вычислений фрактальной
размерности изображений были созданы различные
программные продукты, среди которых можно вы-
делить плагин FracLac (Karperien, 2004) как допол-
нение для свободно распространяемого программ-
ного обеспечения ImageJ. Его преимуществами яв-
ляются бесплатный доступ, понятный интерфейс и
настройки, позволяющие точно подобрать парамет-
ры вычисления для интересующего набора изобра-
жений.

Одним из объектов в клеточной биологии, кото-
рые нуждаются в качественной и количественной
оценке, является фибриллярный (F) актин. F-актин
(состоящий из глобулярного G-актина) и актин-
связывающие белки формируют актиновый цитос-
келет клетки (Fletcher, Mullins, 2010). В структуре
цитоскелета нативных клеток F- и G-актин находят-
ся в постоянном динамическом балансе: с плюс-
конца нити происходит сборка филамента, а с ми-
нус-конца его разборка (Neuhaus et al., 1983). Акти-
новый цитоскелет имеет критическое значение для
клеточной подвижности и миграционного потенци-
ала немышечных клеток как в норме, так и при раз-
личных патологиях, включая метастазирование и

Принятые сокращения: ИФ – интенсивность флуоресценции;
ПНП – предсердный натрийуретический пептид; ФРМ –
фрактальная размерность Минковского; DMSO – диметил-
сульфоксид; Lat B – латрункулин Б.
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диссеминацию раковых клеток. Наиболее широко
распространенным методом выявления F-актина в
клетках является флуоресцентная микроскопия. В
препаратах клеток F-актин окрашивают специфиче-
скими антителами, или с помощью фаллоидина,
природного актин-связывающего соединения рода
фаллотоксинов, конъюгированного с флуоресцент-
ными красителями. Важно отметить, что фаллоидин
специфически связывается с нитями F-актина, и, в
то же время, не способен присоединяться к G-акти-
ну (Cooper, 1987).

Ранее нами было обнаружено, что предсердный
натрийуретический пептид (ПНП) способен влиять
на организацию F-актина и подвижность мезенхим-
ных стволовых клеток линии FetMSC (Ревитцер и
др., 2019). Цель настоящей работы заключается в
проведении количественной оценки состояния
структур F-актина в клетках FetMSC, обработанных
ПНП или латрункулином Б (Lat B), с помощью вы-
числения фрактальной размерности Минковского
(Revittser et al., 2021).

МАТЕРИАЛ И МЕТОДИКА

Клетки. Мезенхимные стволовые клетки, выде-
ленные из костного мозга 5–6 недельного эмбриона
человека (FetMSC) получены из Центра коллектив-
ного пользования ИНЦ РАН (Санкт-Петербург)
“Коллекция культур клеток позвоночных” (Согла-
шение № 075-15-2021-683) (Крылова и др., 2012). Пе-
ред экспериментами клетки высевали на покровные
стекла, помещенные в чашки Петри, плотность со-
ставляла 104 клеток/см2. В качестве питательной сре-
ды использовали DМЕМ/F12 (Биолот, Россия), со-
держащую 10% сыворотки плодов коровы (HyClone,
США), 2 мМ L-глутамина, смесь пенициллина
(50 Ед/мл) и стрептомицина (50 мкг/мл) (Биолот,
Россия). Клетки культивировали в инкубаторе при
37°С, 5% СО2 и 90%-ной влажности, смену среды
проводили каждые 2–3 сут, эксперименты проводи-
ли на клетках, достигших субконфлюентности.

Обработка модификаторами актинового цитоске-
лета. В работе использовали хорошо изученный мо-
дификатор актинового цитоскелета токсин биологи-
ческого происхождения Lat B (Spector et al., 1989).
Lat B растворяли в DMSO (25 мг/мл). Механизм дей-
ствия Lat B на актиновый цитоскелет клетки известен:
связываясь с мономерами актина в стехиометрии 1 : 1
он ингибирует его полимеризацию, что препятствует
образованию новых актиновых филаментов. Обра-
ботку клеток Lat B в концентрации 10 или 1000 нМ в
среде культивирования проводили в течение 30 мин
в СО2-инкубаторе; в качестве контроля использова-
ли клетки без обработки или клетки после действия
1 мкМ диметилсульфоксида (DMSO, растворителя
для Lat B). Во второй серии экспериментов клетки
обрабатывали ПНП в концентрации 10 или 1000 нМ
в течение 24 ч в СО2-инкубаторе; контрольными

служили клетки без обработки (растворитель для
ПНП − дистиллированная вода).

Выявление F-актина в клетках FetMSC. После
культивирования с исследуемыми веществами клет-
ки фиксировали 10 мин при 25°С 5%-ным раствором
формальдегида в однократном фосфатно-солевом
буферном растворе (PBS). Затем проводили пермеа-
билизацию клеточной мембраны с помощью 0.5%-но-
го раствора Triton Х-100 (10 мин в PBS). Для флуорес-
центного мечения F-актина образцы инкубировали
с фаллоидином, конъюгированным с родамином
(TRITC-phalloidin, 1 мкг/мл; Sigma-Aldrich, Германия)
в течение 15 мин при 37°С. Ядра окрашивали с помо-
щью красителя Hoechst 33342 (Sigma, США; 2 мкг/мл в
PBS). Далее покровные стекла крепили к предмет-
ному стеклу, используя среду Vectashield Mounting
Media (Vector Labs, США), препятствующую “выгора-
нию” образцов. Микрофотографии получали с ис-
пользованием лазерного сканирующего конфокально-
го микроскопа Olympus FV3000 (Оlympus Сorporation,
Япония), укомплектованного лазерами с длиной вол-
ны возбуждения 561 и 350 нм (для выявления родамин-
фаллоидина и красителя Hoechst 33342 соответствен-
но). Параметры мощности лазеров, апертурной диа-
фрагмы, свойства регистрирующих фотоумножителей
были постоянными при визуализации всех препара-
тов.

Измерение относительной интенсивности флуорес-
ценции (ИФ) и фрактальной размерности Минковско-
го. Использовали программу ImageJ (NIH, США).
Предварительно в меню Analyze → Set measurements
устанавливали измерение “среднее значение серо-
го” (Mean gray value). Далее в микрофотографии вы-
деляли слой, содержащий изображение F-актина, и
переводили его в 8-битный формат, содержащий толь-
ко оттенки серого (функция Image → Type → 8-bit).
После этого с помощью курсора выделяли область
клетки “свободное выделение” (Freehand selection) и
получали значение ИФ выделенного участка с помо-
щью функции Analyze → Measure. Данные заносили
в таблицу Microsoft Excel (Microsoft Ofiice, США),
итоговые значения ИФ представлены средними из
10 измерений (n) и их стандартной ошибки, досто-
верность различий оценивали с помощью дисперси-
онного анализа с уровнем значимости Р < 0.05.

Измерение ФРМ проводили с помощью плагина
FracLac (NIH, США). Предварительно в плагине
устанавливали тип измерений Box-counting. Далее с
помощью функции Image → Color → Split Channels в
микрофотографии выделяли канал, содержащий
изображение F-актина. После этого полученное
изображение переводили в черно-белый формат с
помощью функции Process → Binary → Make Binary
и возвращали “скелет” фигуры с помощью Process →
→ Binary → Skeletonize. Затем с помощью курсора
(Freehand selection) выделяли область клетки и в пла-
гине FracLac проводили расчет ФРМ с помощью
функции Scan. Полученные данные вносили в таб-
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лицу Exсel, итоговые значения ФРМ представлены
средними из 10 измерений (n = 10) и их стандартной
ошибки, достоверность различий оценивали с помо-
щью дисперсионного анализа с уровнем значимости
Р < 0.05.

РЕЗУЛЬТАТЫ И ОБСУЖДЕНИЕ

Окрашивание F-актина в клетках FetMSC после
действия Lat B. Известно, что фаллоидин специфич-
но связывается с F-актином, поэтому качественная
и количественная оценка окрашенных нитей актина
может отражать сборку или разборку актинового ци-
тоскелета (Cooper, 1987). Мы окрашивали F-актин
клеток FetMSC родамин-фаллоидином в контроле
(рис. 1а), и в образцах, обработанных 1000 нМ DMSO
(растворителем Lat B; рис. 1б) и Lat B в концентра-
ции 50 нМ (рис. 1в) и 1000 нМ (рис. 1г). В контроль-
ных условиях, как и в присутствии DMSO или 50 нМ
Lat B все клетки имеют фибробластоподобную мор-
фологию и выраженные стресс-фибриллы, что ти-
пично для меземхимных стволовых клеток. Как и
следовало ожидать, после обработки клеток 1000 нМ
Lat B мы не наблюдали выраженных стресс фиб-
рилл, а само окрашивание было дисперсным и не
имело четко выраженной организации. Полученные
результаты согласуются с описанным ранее в лите-
ратуре действием Lat B: при малых концентрациях
(менее 50 нМ) вещество не оказывает влияния на ак-
тиновые структуры, а при концентрациях 500 нМ и
выше ингибирует сборку актиновых фибрилл в клет-
ке (Wakatsuki et al., 2001), что приводит к паттерну
флуоресцентного окрашивания, схожему с наблюда-
емым нами в FetMSC. Процессы формирования ни-

тей актина в клетке динамичны, а именно включают
в себя постоянную сборку нити с одного конца и ее
разборку с другого; по этой причине ингибирование
сборки нитей при инкубации Lat B вызывает ее по-
следующую разборку (Spector et al., 1989).

Численная оценка разборки F-актина после дей-
ствия Lat B. Оценку (в каждой крупе было по 10 кле-
ток) проводили двумя методами: с помощью вычис-
ления ИФ или ФРМ (рис. 2 и табл. 1). Применяя
дисперсионный анализ, мы не выявили отличий
между контрольной группой клеток и группой, об-
работанной 1000 нМ DMSO ни по параметру ИФ, ни
по параметру ФРМ, что указывает на отсутствие
влияния растворителя DMSO на F-актин FetMSC.
Кроме того, не было выявлено различий между кон-
трольной группой и группой, обработанной 10 нМ
Lat B. Мы предполагаем, что этой концентрации ве-
щества, по-видимому, недостаточно для детектируе-
мого ингибирования полимеризации актина и раз-
рушения цитоскелета за 30 мин действия. Наши ре-
зультаты согласуются с данными из литературы. Так,
показано, что при воздействии Lat B в концентра-
ции 10 нМ на клетки линии NIH/3T3 в течение
30 мин перед фиксацией не выявлено значимых раз-
личий в структуре F-актина по сравнению с контролем
ни с помощью визуального анализа микрофотогра-
фий, ни с помощью сравнения значений ИФ (Liu et al.,
2020). Другие авторы также не наблюдали измене-
ний свойств клеток при воздействии Lat B в концен-
трациях ниже 50 нМ (Wakatsuki et al., 2001). Мы об-
наружили достоверные различия средних значений
ИФ и ФРМ между контрольной группой и группой,
обработанной 1000 нМ Lat B, что совпадает с визу-

Рис. 1. Флуоресценция F-актина (красный цвет) клеток FetMSC, окрашенных родамин-фаллоидином в контроле (а) и после
30-минутного действия Lat B в концентрации 50 нМ (в) и 1000 нМ (г). б – После 30-минутного действия 1000 нМ DMSO (рас-
творителя Lat B). Ядра окрашены Hoechst (синий цвет). Масштабная линейка: 50 мкм.

а б в г
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альной оценкой микрофотографий окрашенного
F-актина (рис. 1).

Таким образом, наблюдаемые изменения струк-
туры F-актина были подтверждены при численной
оценке как с помощью измерений ИФ, так и при рас-
чете ФРМ, при этом уровни достоверной значимости
различий составили P < 0.05 для ИФ и Р < 5 × 10–7 для
ФРМ, которые свидетельствуют о том, что оценка
значений ФРМ является более чувствительным по-
казателем, чем ИФ в данной серии экспериментов.

Оценка изменений структуры F-актина в FetMSC
после действия ПНП. В настоящей работе, как и ра-
нее (Ревитцер и др., 2019), мы наблюдали сборку
F-актина при воздействии ПНП в концентрации
10 нМ в течение 24 ч перед фиксацией (рис. 3а–в).
Эти результаты подтверждаются анализом литерату-
ры: показано, что добавление 10 нМ ПНП в культу-
ральную среду эндотелиальных клеток аорты вызы-
вает сборку F-актина (Kook et al., 2003; Chen et al.,

2008). В то же время мы не обнаружили различий ор-
ганизации F-актина между контрольными клетками
и клетками, обработанными 1000 нМ ПНП, что тоже
согласуется с нашими предыдущими результатами
(Ревитцер и др., 2019). Этот факт вызывает особый
интерес, а анализ литературы позволяет обнаружить,
что существует несколько примеров веществ, кото-
рые оказывают действие только в малых концентра-
циях, а при ее повышении эффекта нет. Среди таких
веществ можно выделить трансформирующий фак-
тор роста β1 (Pepper et al., 1993) и бортезамиб (Veschi-
ni et al., 2007). Подобный тип влияния называется
U-образным (u-shape) или bell-образным (bell-
shape) (Reynolds et al., 2010).

Численная оценка перестроек F-актина после дей-
ствия ПНП. Мы оценили ФРМ F-актина для клеток,
обработанных ПНП в различных концентрациях в те-
чение 24 ч перед фиксацией и окрашиванием (рис. 3,
табл. 1). В табл. 1 показано сопоставление значений
ФРМ, полученных в настоящей работе, со значениями
ИФ, рассчитанными нами ранее (Ревитцер и др., 2019).
Выявленные в настоящей работе значения ФРМ со-
ставили для контрольной группы 1.45 ± 0. 05 отн. ед.;
для клеток, обработанных 10 или 1000 нМ ПНП,
1.56 ± 0.05 и 1.43 ± 0.04 отн. ед. соответственно.

Применяя дисперсионный анализ, мы выявили
различия значений как ФРМ, так и в ИФ между кон-
трольной группой и группой клеток, обработанных
10 нМ ПНП. Однако мы не выявили различий между
контролем и группой клеток, обработанных ПНП в
большей концентрации (1000 нМ). Уровни значимо-
сти составили P < 0.05 как для ИФ, так и для ФРМ,
что указывает на схожий уровень чувствительности
используемых методов и оценок в данной серии экс-
периментов. Полученные результаты согласуются с
визуальной оценкой микрофотографий и данными,
опубликованными ранее (Ревитцер и др., 2019), в
том числе показывающими изменение подвижности
FetMSC при воздействии только 10 нМ ПНП.

Качественная оценка изменений F-актина не
всегда является надежным методом, так как во мно-

Рис. 2. Интенсивность флуоресценции (ИФ) (а) и фрактальная размерность Минковского (ФРМ) (б) F-актина в контроле и
при действии Lat B в разной концентрации. Представлены средние значения и стандартная ошибка среднего. Отличия от
контроля (К) достоверны при *Р < 0.05 или **Р < 5 × 10−7.
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Таблица 1. Значения показателей ИФ и ФРМ в клетках
FetMSC контрольных и после обработки Lat B или ПНП
в различных концентрациях

Примечание. Приведены средние значения и их стандартные
ошибки. Различия по сравнению с контролем достоверны при
аP < 0.05 и бР < 5 × 10−7 (n = 10 в каждой группе). Значения ИФ
при действии ПНП взяты из: Ревитцер и др. 2019.

Условия ИФ, отн. ед. ФРМ, отн. ед.

Lat B в течение 30 мин
Контроль 1624 ± 438 1.54 ± 0.06
DMSO, 1000 нМ 1633 ± 336 1.52 ± 0.08
Lat B, 10 нМ 1625 ± 325 1.57 ± 0.08
Lat B, 1000 нМ *1177 ± 350а 1.40 ± 0.07б

ПНП в течение 24 ч
Контроль 1824 ± 237 1.45 ± 0. 05
10 нМ ПНП 2408 ± 292а 1.56 ± 0.05а

1000 нМ ПНП 1751 ± 201 1.43 ± 0. 04
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РЕВИТЦЕР и др.

гом зависит от личного мнения исследователя, осу-
ществляющего эту оценку. Чтобы обеспечить объек-
тивность оценки результатов экспериментов, следует
прибегнуть к количественным методам. В настоящей
работе были рассмотрены два метода квантификации:
измерение относительной ИФ и ФРМ. Оба метода по-
казали себя способными выявлять и подтверждать
изменения организации F-актина при действии
биологически активных веществ (Lat B и ПНП),
причем в случае с Lat B достоверность измеряемых
значений различий была существенно выше в случае
ФРМ, чем ИФ. В настоящее время чаще оценивают
ИФ, чем ФРМ для квантификации изменений, что
можно связать с простотой регистрации в ходе рас-
чета ИФ. Однако необходимо заметить, что ФРМ, в
отличие от ИФ, позволяет учитывать не саму интен-

сивность свечения флуоресцентных изображений F-
актина, а именно форму и расположение актиновых
фибрилл. Таким образом, разные принципы получе-
ния численных значений делают ФРМ и ИФ взаи-
модополняющими методами при квантификации
изображений F-актина.
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Клетки FetMSC получены из Центра Коллективного
Пользования “Коллекция культур клеток позвоночных”
Института цитологии РАН (Санкт-Петербург), поддержан-
ного Минобрнауки РФ (Соглашение № 075-15-2021-683).

Рис. 3. Флуоресцентное окрашивание F-актина клеток FetMSC в контроле и после 24-часового действия ПНП. а – Контроль
(К); б – 10нМ ПНП; в – 1000 нМ ПНП; г – ФРМ изображений F-актина, приведены средние значения и стандартная ошибка
среднего, различия достоверны при *Р < 0.05. Масштабная линейка: 100 мкм.
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The Analysis of F-Actin Rearrangement in FetMSC Human Mesenhymal Stem Cell Line 
Using Minkovsky Fractal Dimension

A. V. Revittsera, *, V. I. Chubinskiy-Nadezhdina, and Y. A. Negulyaeva

aInstitute of Cytology Russian Academy of Sciences, St. Petersburg, 194064 Russia
*e-mail: eetytnet@gmail.com

Quantification of fibrillar actin rearrangements using cell microphotographs is possible not only with the routine
measurement of the relative f luorescence intensity, but also using Minkowski’s fractal dimension. Here, the FracLac
plugin for ImageJ was used to calculate the fractal dimension. Fibrillar actin rearrangements were detected in FetM-
SC human mesenchymal stem cell line after incubation of the cells with actin polymerization inhibitor latrunculin
B or atrial natriuretic peptide, whose effect on the actin cytoskeleton was recently revealed. The analysis of the im-
ages allowed us to reveal the changes in fractal dimension that reflected the reorganization of microfilaments in the
native cells. The results have demonstrated that the Minkowski fractal dimension is a convenient tool for evaluating
the changes in F-actin structure, and can be successfully used as supplement or replacement for measuring the rel-
ative f luorescence intensity.

Keywords: fibrillar actin, Minkowski fractal dimension, human mesenchymal stem cells
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